Omneon MediaTools EDLTool™
User’s Guide
Release 1.2
Copyright and Trademarks

Copyright © 2000–2008 Omneon, Inc. All rights reserved. Omneon, Omneon, Inc., and the Omneon logo are trademarks of Omneon, Inc. All other trademarks are the property of their respective holders. May be covered by one or more of U.S. Patents No. 6,571,351; 6,696,996; 6,545,721; 6,574,225; 6,895,003; 6,522,649; 6,643,702; foreign counterparts and pending patent applications.

This system is distributed with certain other software that may require disclosure or distribution of licenses, copyright notices, conditions of use, disclaimers and/or other matter. Use of this system or otherwise fulfilling their conditions constitutes your acceptance of them, as necessary. Copies of such licenses, notices, conditions, disclaimers and/or other matter are available in any one of the following locations: the LEGAL NOTICES AND LICENSES directory of the distribution disk of the software, the root directory of the hard disk drive of the Products, online at http://support.omneon.com/LEGAL or by contacting us at support@omneon.com.

Software Release

Release 1.2

Notice

Information contained in this guide is subject to change without notice or obligation. While every effort has been made to ensure that the information is accurate as of the publication date, Omneon, Inc. assumes no liability for errors or omissions. In addition, Omneon, Inc. assumes no responsibility for damages resulting from the use of this guide.

Company Address

Omneon, Inc.
965 Stewart Drive
Sunnyvale, CA 94085-3913
Business Office: +1 (866) 861-5690
# Contents

**Introduction** ......................................................... 1  
EDLTool Features ..................................................... 1  
New in This Release .................................................. 1  
Technical Support ..................................................... 2  

**Chapter 2 Installing EDLTool** ..................................... 3  
System Requirements .................................................. 3  
System Compatibility .................................................. 3  
What Gets Installed .................................................... 4  
Software Installation ................................................... 4  
  Downloading the Software ......................................... 4  
  Installing Microsoft .NET Framework Version 2.0 ................. 4  
  Follow these steps if .NET Framework is not installed on your system ................................................. 4  
  Installing EDLTool .................................................... 4  
EDLTool Licensing ....................................................... 5  

**Chapter 3 Using EDLTool** ........................................... 7  
User Interface and Menu Overview .................................... 7  
  Main Window .......................................................... 8  
  Menu Bar .............................................................. 8  
  Toolbar ................................................................. 13  
  Trimmer Player ....................................................... 13  
  EDL Player ............................................................ 16  
Starting EDLTool .......................................................... 17  
Creating Scene Lists .................................................... 19  
Collecting Clips .......................................................... 20  
  About the Scene List Graphics and Colors ....................... 20  
  Removing Clips From a Scene List .................................. 20  
  Editing Clips .......................................................... 21  
  Moving Edited Clips to the Output Scene List for Review ........ 21  
  Saving the Output ................................................... 22  
Opening EDLTool XML Files in Other Applications ................. 22  
  Opening Files in ClipTool Pro ..................................... 22  
  Mounting the MediaDirector from a Macintosh .................... 23  
  Importing the EDLTool XML Files .................................. 24
Introduction

Omneon MediaTools are low cost, easy-to-use utilities, designed to ensure greater operability for broadcast customers.

Tightly integrated with Omneon ProBrowse™, EDLTool™ is ideal for creating rough cut stories, which can be used for final image and sound assembly using Apple® Final Cut Pro®. You can also build cuts-only (no effects) playlists for direct loading into Omneon ClipTool Pro™.

EDLTool Features

EDLTool provides the following features:

• Drag and drop clips from ProBrowse Explorer directly into EDLTool.
• Trim clips and create highlights from original ProBrowse clips.
• Create a list of scenes from edited clips.
• Save a rough cut scene list as an XML file for use by Final Cut Pro and ClipTool Pro.

This guide provides installation and operating instructions in the following sections:

• Installing EDLTool
• Using EDLTool

New in This Release

Support for User-Defined Timecode Offset

The Setup menu now includes an option for manually setting a timecode offset for an EDL. For details, refer to Setup Menu.
Technical Support

Omneon provides many ways for you to obtain technical and operational support. In addition to contacting your Distributor, System Integrator, or Omneon Account Manager, you can contact the Technical Services department using the Internet, E-mail, phone, or fax.

For support in the Americas:
• +1.888.OVN.SPT1 (1+.888.686.7781) or +1.408.585.5200
• Fax Number: 408.585.5090
• E-mail: support@omneon.com
• http://www.omneon.com or support.omneon.com
• ftp://support.omneon.com

For support in Europe, Middle East and Africa:
• Telephone: +44 1256 347 401
• E-mail: emeasupport@omneon.com
• Fax Number: +44 (0) 1256 347410
• http://www.omneon.com or support.omneon.com

For support in Asia Pacific:
• Telephone: +65 6548 0500
• E-mail: apacsupport@omneon.com
• Fax Number (APAC): +65.6548.0504
• http://www.omneon.com or support.omneon.com

For support in Japan:
• Telephone: +03.5488.7425
• E-mail: japansupport@omneon.com
• Fax Number (Japan): +81.3.5488.7433
• http://www.omneon.com or support.omneon.com

Company Address

Omneon, Inc.
965 Stewart Drive
Sunnyvale, CA 94085-3913
CHAPTER 2
Installing EDLTool

This section provides information about installing EDLTool. The following topics are covered:

- System Requirements
- System Compatibility
- What Gets Installed
- Software Installation
- EDLTool Licensing

System Requirements

Prior to installing EDLTool, your PC must conform to the following minimum requirements and must be connected by Ethernet to your facility's LAN:

- 3 GHz or better Pentium® 4 or equivalent CPU
- At least 1 gigabyte (GB) of RAM
- DirectX® 9.0-compatible graphics adapter
- 20GB hard drive
- At least 5 Megabytes of free disk space
- Windows® XP
- ProBrowse Desktop 2.0 installed
- Microsoft® .NET Framework version 2.0 installed
- Display resolution should be set to 1152 x 864 minimum
- 100 BaseT or better Ethernet (Gigabit Ethernet recommended)

1 You may need to install the DirectX package.

2 Refer to Installing Microsoft .NET Framework Version 2.0.

System Compatibility

EDLTool is compatible with ProBrowse 2.0 SR1 or higher.
What Gets Installed

The following items are included with the EDLTool application:

- EDLTool Release Notes
- EDLTool User’s Guide (this guide)
- Online Help files

Software Installation

Complete the installation procedures in the order below.

Downloading the Software

Before you begin, make sure that the PC on which the EDLTool application will be installed is booted and connected by Ethernet to your Omneon MediaDirector when running the application. It is also highly recommended that you exit all Windows programs at this point.

Complete each of the following installation procedures to install the EDLTool components.

Installing Microsoft .NET Framework Version 2.0

Microsoft .NET Framework version 2.0 must be installed on your system to use EDLTool. The .NET Framework is a key component required to use most new Windows platform applications, including EDLTool.

Prior to installing the .NET Framework, check to see if it is already installed on your system.

1. Use Windows Explorer to navigate to the following location on your system:
   C:\WINDOWS\Microsoft.NET\Framework
2. If you see a v.2.0.x folder you do not need to install .NET Framework.

Follow these steps if .NET Framework is not installed on your system

1. Go to www.microsoft.com and then search for “.NET Framework 2.0” to locate the installer.
2. Follow the steps to download and install .NET Framework version 2.0 on your system.

Installing EDLTool

Complete the following steps to install the EDLTool application on your PC.
1. If you have not already done so, open the **EDLTool.zip** file that you downloaded from the Omneon support Web site, and then extract the files using the password provided by Technical Support. Contact Technical Support if you need assistance.

2. Locate the **EDLTool** executable file icon from the EDLTool.zip folder.

3. Double-click the **EDLTool** icon to begin the installation.

4. Click **Next** and then follow the steps to install EDLTool.

   This completes the EDLTool installation procedure. Refer to **Using EDLTool** to begin using the application.

**EDLTool Licensing**

A license file (provided by Omneon) supplies the licenses for the EDLTool components. This file is installed on the Omneon SystemManager computer.

One license is required for each instance of EDLTool that is in use. These are “floating licenses,” so any connected computer can run the application until the total number of purchased (and licensed) copies are active.

For example: If you have purchased four EDLTool licenses and you have installed the product on 20 computers, you can run up to four instances of EDLTool at any one time. The remaining 16 installations cannot run the tool until one of the first four exits.
A variety of dialog boxes may appear at startup time if the application encounters licensing issues (for example, the license server is down, the license file cannot be found, all licenses are used, etc.). The figure below shows examples of some of the possible messages you may encounter.

Follow the directions in these dialog boxes and/or contact your Network Administrator as required to resolve any issues that arise. Contact Omneon Sales to purchase additional licenses.
CHAPTER 3
Using EDLTool

This section covers the operation of the Omneon EDLTool application. Refer to the Introduction for an overview of the EDLTool features. Choose from the following topics:

• **User Interface and Menu Overview**

An introduction to the EDLTool Main application window, its components and a description of each menu and its options.

• **Starting EDLTool**

Instructions on starting the EDLTool application.

• **Creating Scene Lists**

Detailed instructions on using EDLTool, including creating and editing scene lists and saving the output for ClipTool Pro and Final Cut Pro.

• **Opening EDLTool XML Files in Other Applications**

Instructions for opening EDLTool files using ClipTool Pro and how to set up the Macintosh® computer used to import the EDLTool XML files.

**User Interface and Menu Overview**

This section describes the EDLTool Main window and provides an overview of each menu and its commands. The following topics are covered:

• **Main Window**
• **File Menu**
• **Edit Menu**
• **Clip Menu**
• **Setup Menu**
• **View Menu**
• **Help Menu**
Main Window

The EDLTool Main window provides integrated controls for editing and reviewing the clips to be used for your XML file. The figure below shows a sample Main window.

Following are descriptions of each section above.

Menu Bar

The Menu Bar provides access to the File Menu, Edit Menu, Clip Menu, Setup Menu, View Menu and Help Menu, which are used to operate the EDLTool application. Refer to each menu for complete details.
File Menu

- **New**: close current file/create a new one.
- **Open**: open a previously saved XML file.
- **Save**: save as an XML file.
- **Save As**: save as an XML file.
- **Recent File**: This option is dimmed until a file is saved. Once saved, file names are shown and can be opened with a click.
- **Exit**: close the EDLTool application.

Edit Menu

The Edit Menu options are currently unavailable.

Clip Menu

- **Info**: display the original metadata for the currently-selected clip.
Descriptions of each field or section are as follows:

- **Title**: Enter a name for the clip here.
- **Path**: Displays the current clip’s name and path of the full resolution clip. Click the arrow to the right to view any alternate paths to the clip.
- **Format**: Displays the clip format.
- **Status**: Displays whether the clip has been transcoded.
- **Description**: Add a brief description of the currently-selected clip or scene.
- **Comment**: Add a comment about the currently-selected clip or scene. Comments that you add appear on the clip/scene in its scene list. You can also add a comment directly to a clip/scene in a scene list. Refer to **Creating Scene Lists**.
• **Left/Right Channel:** Displays the currently selected channels for audio playback and any tags assigned to these channels using Omneon’s TrackTool. By default, audio playback occurs from the first two channels. If channels have not been tagged using TrackTool, they are marked as “no tag”. Click the drop down lists to select other channels for playback. Refer to the *Omneon TrackTool User’s Guide* for additional information about TrackTool and the process involved in tagging a track.

• **OK:** Click to confirm changes.

• **Cancel:** Click to cancel any changes and close the dialog.

**Setup Menu**

- **Configuration:** display the **Configuration** dialog box.

  ![Configuration Dialog Box](image)

  - The **Highlight Settings** provide settings for the default inpoint and outpoint of highlights. These values are used when you create a highlight from an existing clip or scene in the Bin Scene List.
  
  - The **XML** section is used to select the MediaDirector Host (Ethernet port) used when creating the mount path for the full resolution clips. Click the arrow to choose the host. The host you choose must be the same host as the one used when mounting the MediaDirector from a Macintosh. Refer to **Mounting the MediaDirector from a Macintosh** for details.
• The **EDL Timecode Offset** section allows you to manually enter a timecode offset for an EDL. The timecode offset is applied to all XML files created.

  • If this option is unchecked, the timecode stored in the current XML file is used for the EDL sequence, and any new XML files will default to 00:00:00:00.

  • To set the timecode for the current EDL, click the **EDL Timecode Offset** checkbox, enter the desired timecode in the **Timecode** field, and then click **OK**.

  • To update to the current XML file with the setting in the **Timecode** field, click the **Set Current EDL** button, and then click **OK**. You must save the XML file for the changes to take effect.

• **Compatibility**: Set the clip format type (MPEG or DV) and the clip bitrate range that you would like the scenes to possess. Scenes that do not meet the compatibility settings are identified in the scene list by a red background behind clip format type. Refer to *About the Scene List Graphics and Colors* for further details.

![Compatibility Settings](image)

**View Menu**

<table>
<thead>
<tr>
<th>View</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ Toolbar</td>
<td>✓ Status Bar</td>
</tr>
<tr>
<td></td>
<td>Show Underburn</td>
</tr>
</tbody>
</table>

• **Toolbar**: display/remove the toolbar.

• **Status Bar**: display/remove the status bar.

• **Show Underburn**: Click to display the clip underburn timecode, if it is available.
Help Menu

- **Help Topics**: Click to open the EDLTool help system.
- **About**: Click to show the version, date and copyright information for EDLTool.

### Toolbar

The Toolbar provides shortcuts for commonly used EDLTool tasks. You can drag the Toolbar from its position to anywhere on the interface or desktop.

1. **New**: close current file/create a new one. You can also press the shortcut keys CTRL+N.
2. **Open**: open a previously saved XML file. You can also press the shortcut keys CTRL+O.
3. **Save**: save as an XML file. You can also press the shortcut keys CTRL+S.

### Trimmer Player

The Trimmer Player is where you edit your clips prior to review on the right-side EDL Player. Clips reviewed in the EDL Player can be refined after review by simply moving the clip back to the Trimmer for further editing.

Refer to [Creating Scene Lists](#) for instructions on building, editing and saving scene lists.
Below the Trimmer Player, VTR-style controls are provided for navigation and clip editing. ToolTips, which describe each control’s function, display when the mouse is placed over the control.

**Player Controls**

The three top fields in the Trimmer Panel Controls are time fields (inpoint, position and outpoint). They display time as timecode.

- **Inpoint**: The point at which the clip is set to begin. You can change the inpoint by typing a new timecode value directly into the field and then pressing the ENTER key.
- **Position**: Shows the current play position of the clip. Direct the player to go to a specific timecode number by entering the position and pressing ENTER. You can also click and drag the Play Status slider to browse the clip position.
- **Outpoint**: The point at which the clip is set to stop. You can change the outpoint by typing a new timecode value directly into the field and then pressing the ENTER key.

Below are descriptions of each of the controls, from left to right:

- **Go to inpoint** (Trimmer only): Click to go to the clip’s inpoint.
- **Clear inpoint** (Trimmer only): Click to clear the clip’s inpoint.
- **Mark inpoint** (Trimmer only): Click to set the current position as the clip’s inpoint.
- **Create a highlight**: Click to create a new clip highlight from the current clip position. The inpoint is automatically set to five seconds before the current position and the outpoint is set to two seconds after the current position. The new highlight is placed at the end of the Bin Scene List. The current frame is used as the highlight’s picon in the scene list.

Select **Configuration** from the Setup menu to change the default in and outpoints. Refer to **Setup Menu** for details.
- **Mark outpoint** (Trimmer only): Click to set the current position as the clip’s outpoint.
- **Clear outpoint** (Trimmer only): Click to clear the clip’s outpoint.
- **Go to outpoint** (Trimmer only): Click to go to the clip’s outpoint.
- **Previous scene change**: Click to go to the previous scene within a clip’s timeline (Trimmer); go to the previous scene or subclip in the Output Scene List.
- **Back one second**: Pause any playback and back up the clip by one second.
- **Jog back one frame**: Pause any playback in progress and back up the clip by one frame. You can also hold the K key and press J to jog backward (Trimmer only).
- **Play/Pause**: Click to start/pause playback of the clip.
- **Jog forward one frame**: Pause any playback in progress and advance the clip by one frame. You can also hold the K key and press L to jog forward (Trimmer only).
- **Forward one second**: Pause any playback and advance the clip by one second.
- **Next scene change**: Click to go to the next scene within a clip’s timeline (Trimmer); go to the next scene or subclip in the Output Scene List.
- **Loop** (check box): Check this box to specify that the clip should replay upon completion. Clear the check box to disable looping.
- **Play Status** (slider): Shows the play progress for a clip. Click and drag the slider to advance or reverse play.
- **In/Out** check box (Trimmer only): Select to show the inpoint and outpoint, represented by a horizontal blue line. Check this box to specify that clip playback should occur between clip in and outpoints only. You can also jog beyond the in and outpoints to mark new in/outpoints.
- **Playback Speed Control** (Trimmer only): This shuttle mechanism allows playback from 1/4 to 4x speed. Click and drag the slider to decrease or increase the playback speed. In this mode, the audio speed matches the playback speed.

The following keyboard shortcuts also control playback speed (Trimmer only):

- J: reduce the playback speed a factor of 2
- K: pause playback and return the speed to 1
- L: increase the speed by a factor of 2
- **Go back** (Trimmer only): Click during playback to replay the clip from a previous position (from two to 10 seconds earlier). The position returned to depends on the current playback speed. Playback is reset to 1x if the play speed is greater than 1x when the button is clicked.
- - Ch X, Y + (slider): Click and drag this slider to control the volume.

**Details Pane**

- The **Details Pane** displays information about the clip currently selected in the Bin Scene List or the Output Scene List. Note that you can press CTRL+C with the clip Path selected to copy the clip’s path.
EDL Player

The EDL Player is where you review the sequence of clips that you built using the Trimmer Player. Move clips from the Trimmer to the EDL Player using a drag-and-drop operation.

The following shortcut keys are available to the EDL Player:

- **J, K**: pause the clip
- **L**: play the clip

Refer to **Player Controls** for descriptions of all of the EDL Player controls.
**Starting EDLTool**

This section provides instructions on starting the EDLTool application.

1. Make sure ProBrowse Explorer is running.
   
   An EDLTool icon is placed on your desktop during installation of the program. Use the following steps to operate EDLTool for the first time. To use EDLTool after first-time setup, just double-click the desktop icon.

2. Double-click the **EDLTool** icon.

![EDLTool Icon](image)

3. Click **Specify the License Server**, and then click **Next**.

![FLEXlm License Finder](image)

4. Enter the IP address or host name of the license server on the **FLEXlm License Finder** screen and then click **Next**. Contact your System Administrator if you do not know this information.
5. EDLTool accesses the license server and verifies availability of licenses. If licenses are available, the following screen displays:

6. Click Finish to begin using EDLTool.

   Contact your Network Administrator as required to resolve any issues that arise. Contact Omneon Sales to purchase additional licenses.
Creating Scene Lists

EDLTool provides side-by-side players and scene lists used for editing clips and reviewing the output prior to saving the XML file. The scene list on the left is the Bin, a collection of the clips to be used as building blocks for the final output. The right side is the Output, a combined scene list of the edited clips. This scene list is used for review before it is saved as an XML file. Scene lists may contain scenes and sections of scenes (subclips).

The EDLTool XML file is created by editing the clips in the Bin and then moving them to the Output for final review and export. Refer to Collecting Clips to load clips.
Collecting Clips

With both ProBrowse Explorer and EDLTool started, move the desired clip(s) from ProBrowse Explorer to EDLTool using a drag-and-drop operation. Drop the clips anywhere on the left side of the interface (Trimmer) to load the clips in the order placed. You can also add clips between other clips by releasing the mouse button with the pointer placed at the desired position in the scene list.

Additional operations:

- Clips may also be placed directly in the Output Scene List.
- Move clips from the Bin to the Output and vice versa by dragging the clip to the appropriate position.
- To duplicate a clip or scene within a scene list, press SHIFT and then drag the clip/scene to the desired location.

Tip: Click the Comment field to add a comment about the scene. Type your comment and then press ENTER to save it.

Note that scene changes—a point in a clip where there is a cut—only exist in ProBrowse Explorer. If clips containing scene changes are loaded into EDLTool from ProBrowse Explorer, their outpoint is automatically defined as follows:

- the next scene change
- the outpoint of the clip, if it is greater than the scene change position
- the last frame of the clip

About the Scene List Graphics and Colors

The following graphics and background colors are used to represent different clip and scene characteristics. Refer to Setup Menu for information on changing compatibility settings.

- Green check mark: the clip/scene resides on the default file system.
- Red cross: the clip/scene does not reside on the default file system.
- White background behind clip format type (e.g., MPEG): the clip/scene matches the expected format selected in the Compatibility dialog box.
- Red background behind clip format type (e.g., MPEG): the clip/scene does not match the expected format selected in the Compatibility dialog box.
- A play icon along with the words “TRIM” or “EDL” represents the currently active scene in either the Trimmer or EDL Player.

Removing Clips From a Scene List

Clips can be removed in one of two ways:

- To remove a clip, select the clip and press the DELETE key.
• To remove a number of specific clips, hold down the CTRL key while selecting the clips and then press DELETE.
• To remove all clips from both scene lists, click the New icon on the toolbar or press CTRL+N.

Editing Clips

Once all of the clips are gathered in the Bin, use the Trimmer Player Controls to either modify a clip or to duplicate a section of a clip, known as a highlight. Refer to Player Controls for descriptions of each editing tool.

Playing Clips in the Trimmer Player

1. Double-click the clip that you want to play to load the clip in the Trimmer player.
2. Click the Play button to begin playback. Clips are played one at a time.

In addition to using the Trimmer Player Controls, the following editing features can be performed:

• Modifying scene metadata: Scene metadata can be edited in one of two ways:
  • Load the scene into the Trimmer and mark a new in or outpoint different from the scene’s inpoint/outpoint.
  • Add a description or comment in the Info dialog box. Refer to Clip Menu for details.

Moving Edited Clips to the Output Scene List for Review

Move the edited scenes that you want to use for your final file from the Bin to the Output Scene List using a drag-and-drop operation. The Output always shows the clips in the current scene list in playback order. Reorder scenes in the Output by dragging a scene to the desired position.

The EDL Player pauses playback if you drag a clip into the Output Scene List. The play position is then moved to the start of the added clip. Click the Play button in the EDL Player controls to resume playback.

Output data fields may differ from those seen in the Bin; for example, the inpoint/outpoint values shown in the Bin are those of the subclip’s timeline position, not those of its position in the original media file.

Playing Back the Output Scene List

Select the first scene in the Output and then click the Play icon in the EDL Player controls to begin playback of the scene list from start to finish.

NOTE: During playback of a sequence of short clips, the playback may stall at clip transitions while the next clip is queued.

The following operations can be performed while reviewing the Output:

• Move scenes within the Output to rearrange the order.
• Remove clips from the Output by selecting the scene and pressing the DELETE key.

• Double-click a clip in the Output to load the clip into the Trimmer for editing. Text displays on the scene list picon to identify the active clip in each player (“TRIM” or “EDL”).

• Click any non-playing clip in the Output to jump to and continue play from that clip.

Saving the Output

Once you have completed your review of the Output you can save it as an XML file to be used by ClipTool Pro and Final Cut Pro. Scene lists can also be saved during the editing process.

1. Select Save from the File menu.

2. Name the file and then save it to your preferred location.

The output is saved as an XML file and available for use by other applications. Refer to Opening EDLTool XML Files in Other Applications for instructions.

Opening EDLTool XML Files in Other Applications

The saved EDLTool XML files can be used by Omneon ClipTool Pro and Apple Final Cut Pro. Refer to the following sections for details.

Opening Files in ClipTool Pro

The output that you create using EDLTool can be opened using ClipTool Pro. Follow these steps to open files using ClipTool Pro. See the Omneon ClipTool Pro User’s Guide for detailed instructions.

Before you begin:

• Make sure the computer on which ClipTool Pro is installed has access to the saved XML files from EDLTool.

• Make sure that the MediaDirector to which ClipTool Pro connects contains the clips referenced in the XML files from EDLTool.

1. Start the ClipTool Pro application.

2. Select Open Playlist from the ClipTool Pro File menu.

3. Locate the XML file and then select Open.
Mounting the MediaDirector from a Macintosh

The Macintosh® computer must be set up to access the EDLTool XML files that are saved on the MediaDirector. You can then open the files using Final Cut Pro for further editing and final production. Follow these steps to set up the Mac.

1. On the Mac, select **Connect to Server** from the Go menu.

2. Each MediaDirector host is associated with a particular Ethernet port and each has a unique IP address. Enter the IP address of the MediaDirector’s host used for the full resolution clips. The host you choose must be the same host as the one selected in the **Configuration** dialog box. Refer to **Setup Menu**.
3. Select **Connect as Guest** and then click the **Connect** button to connect to the MediaDirector.

4. Select the volume to mount on the MediaDirector and then click **OK**.

**Importing the EDLTool XML Files**

Follow these steps to import the EDLTool XML files into Final Cut Pro.

1. Within the Final Cut Pro application, select the **File** menu.
2. From the File menu, select **Import > XML**.
3. Find the location of the XML file from EDLTool and then open the file.

**NOTE:** Final Cut Pro displays some non-critical errors about the XML files from EDLTool. These errors occur because of specific EDLTool and ClipTool Pro metadata stored in the XML file. The errors can be ignored safely.
# Index

## A
- About EDLTool 13

## B
- Bin Scene List 19

## C
- Clip
  - compatibility settings 12
  - editing 21
  - information 9
  - removing from scene list 20
  - show underburn 12
- Clip Menu 9
- ClipTool Pro, opening files with 22
- Comments, adding to scene 10
- Configuration, highlight 11
- Copyrights ii

## D
- Details pane 15

## E
- Edit Menu 9
- EDL Player 16
- EDLTool
  - about 1
  - exit 9
  - features 1
  - installing 3, 4, 5
  - licenses 5
  - Main Window 8
  - starting 17

## F
- Features 1
- File Menu 9
- Final Cut Pro, opening files with 24
- FLEXlm License 5

## H
- Help Menu 13
- Highlight settings 11
- Highlight, creating 14

## I
- Inpoint, Trimmer Player 14
- Installation 3, 4, 5

## K
- Keyboard shortcuts 15, 16

## L
- Licenses, EDLTool 17

## M
- Main Window 8
- MediaDirector, mounting from a Mac 23
- Menu Bar 8

## N
- New clip 13

## O
- Open clip 9, 13
- Outpoint, Trimmer Player 14
- Output Scene List 19

## P
- Position, Trimmer Player 14

## S
- Save clip 9, 13
- Scene List
  - Bin 19
  - creating 19
  - Output 19
  - playing back 21
  - saving 22
- Scene Lists, creating 20
- Setup Menu 11
- Shortcut keys
  - EDL Player 16
  - Trimmer Player 15
- Starting EDLTool 17
- Status Bar 12
- System Requirements 3